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项目存取(Project Access) 

Vantage PDMS使用环境变量定义PDMS软件的位置和项目。  

示范项目 

PDMS提供三个示范项目： 
SAM  Sample Project (Metric) 
IMP  Sample Project (Imperial) 
MAS Master Catalogue  
示范项目放在 PDMS 执行目录下的 Project目录中。 

 
示范项目的环境变量设置在文件 \AVEVA\pdms11.5\evars.bat中。 
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批处理文件中检查变量是否已经设置，如果没有设置，则指向缺省路径。 

在批处理文件中添加项目环境变量  

如果你希望将项目放在网络中的其他地方，你必须修改项目的环境变量。修改和添加项目
环境变量在 PDMS.bat文件中进行，文件在 PDMS执行目录中。 
 
编辑这个文件的一种方法是在Window开始菜单中的Run PDMS菜单项上点鼠标右键，然
后选择编辑 Edit。 
 
下面是如何设置环境变量的例子： 
 
SET SAM000=D: \AVEVA\pdms11.5\PROJECT \SAM000 
SET SAMMAC=D: \AVEVA\pdms11.5\PROJECT\SAMMAC 
SET SAMISO=D: \AVEVA\pdms11.5\PROJECT \SAMISO 
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SET SAMPIC=D: \AVEVA\pdms11.5\PROJECT \SAMPIC 
 
SET MAS000=D: \AVEVA\pdms11.5\PROJECT \MAS000 
SET MASPIC=D: \AVEVA\pdms11.5\PROJECT \MASPIC 
 
新的设置应该放在 PDMS.bat文件中的@echo off行后面  

 
注意：只在批处理文件中修改环境变量，而不要在系统变量中设置，因为这样可能会在
PDMS不同版本中引起冲突。 

建立新项目(Creating a new Project) 

1. 建立项目目录D:\ABCPROJ。 
在项目目录 D:\ ABCPROJ下面建立新的PDMS项目，需要创建四个子目录。目录名称中
前三个字母必须是由三个字母组成的项目代码，下面以 ABC作为新建项目的项目代码。 
ABC000 存放项目中的所有数据库。 
ABCMAC 存放交叉数据库连接宏（ inter-DB connection macros） 
ABCPIC 存放平面图的映射文件 
ABCISO 存放与 ISODRAFT出图设置相关的文件 
在MAS项目中，因为没有 Design模型和 Iso图，所以没有MAS000和 MASISO 目录。  
2. 在 ABCISO 目录下面建立四个子目录。也可以从 SAM项目中拷贝过来，同时将生成

ISO图的选项文件拷贝过来。 
LIS  存放详细列表。 
STD  存放标准 Iso图的设置文件 
SYS  存放系统 Iso图的设置文件 
UND  存放管段图图框 
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3. 在\AVEVA\pdms11.5\PDMS.bat中设置环境变量。 
set ABC000=D:\ PROJECT \ABC000 
set ABCISO=D:\ PROJECT \ABCISO 
set ABCMAC=D:\ PROJECT \ABCMAC 
set ABCPIC=D:\ PROJECT \ABCPIC 
4. 在开始菜单中AVEVA程序组中运行 Make PDMS Project项，启动项目生成程序。它
实际运行的是\AVEVA\pdms11.5\make.bat文件。根据提示输入项目代码 ABC 

5. 出现 * 命令提示符后运行宏文件，键入$m  \%PDMSEXE%/makemac.mac。程序提示
Creating module definitions referencing %pdmsexe% 

6. 键入 finish完成 PDMS项目生成。 

 
7. 可以看到 ABC000目录中包含 SYSTEM数据库 ABCSYS， COMMS数据库

ABCCOM，MISC数据库ABCMIS， 

 
8. 在新的项目中已经自动生成了一个组 MASTER,组中有一个用户 SYSTEM,是超级
（FREE）用户，密码是 XXXXXX(大写)。现在可以以用户 SYSTEM进入 PDMS的
ADMIN管理模块。 

项目设置 

进入项目管理 

项目管理必须以用户 SYSTEM进入项目 ABC的 ADMIN管理模块。 
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设置项目支持中文字符 

支持中文字符包括中文菜单的显示，中文的输入输出。 
Display>Command Line,在 Admin的命令行输入： 
PROJECT  MBCHARSET  CHI 

设置项目信息 

Porject>Information… 设置项目的信息。其中 Name, Description, Message 最大设置 119个字
符，Number 最大 16个字符。 
Login界面中显示的是 Description 
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项目规划一：单写数据库  

项目规划的内容  

项目规划的内容包括定义组，用户，数据库和数据库组。 
组相当于专业组，用户属于各个专业组，数据库相当于各个专业组的设计数据，一般每个
专业组都有自己的数据库，而且，只有本专业组的用户对属于本组的数据库才有更改的权
利。一个专业组的用户想要看到其他人的设计数据，就要用到数据库组。数据库组是把相
关专业的设计数据库组合在一起。对其他专业的数据库只有读的权利，没有写的权利。 
 

 

组 TEAM 

练习一：生成下面的组 CREATE TEAM 

组描述  组名称 
管道设计 A组-负责管带区的管道，设备设计和出图 PIPEA 
管道设计 B组-负责框架区的管道，设备设计和出图 PIPEB 
管道设计 C组-负责塔区的管道，设备设计和出图 PIPEC 
管道设计 D组-负责炉区的管道，设备设计和出图 PIPED 

钢结构设计组-负责全部的钢结构设计 STEEL 
材料组-负责建元件库 CATS 
项目组-具体负责出图风格管理，查看项目进度  ADMIN 

平面图管理组-平面图出图风格管理 DRAFTADMIN 
单管图管理组-单管图出图风格管理 ISOADMIN 

项目经理组（已建立） MASTER 
提示：DRAFTADMIN和 ISOADMIN组的命名不能修改。 
完成后如下图： 

 框架区 塔区 

 炉区 

管带区 

P-101 

V-101 

CV-
101 

150-P-2003-2.5A1-HI 
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数据库类型 DATABASE 

PDMS项目中包括管理数据库和模型数据库。 

管理数据库  

SYSTEM—保存模型数据和模块的存取控制数据。用户，组和数据库信息。  
COMMS—保存用户，模块和数据库的关系信息。 
MISC—保存交叉用户信息，和交叉数据库宏。 

模型数据库  

DESIGN—项目中的所有设计数据。 
DRAFT（PADD）—模块生成的各种平竖面图。 
CATALOGUE—项目元件库和等级库。 
PROPERTIES—元件库参考的材料属性。 
DICTIONARY—用户自定义属性（UDAs）。 
COMPARATOR—与 Design Manager软件连接的数据库。没有该软
件则不需要这种数据库。 

ISOD— SPOOLER模块生成的管道预制图。 

数据库之间的关系 

1. DESIGN设计数据库从 CATALOGUE数据库中获得元件数据。 
2. CATALOGUE和 DESIGN数据库需要指向 PROPERTIES数据库中的材料属性。 
3. PADD和 ISOD数据库需要指向 DESIGN 设计数据库。 
4. DESIGN，CATALOGUE和 PADD数据库中用到的用户定义属性的定义保存在

DICTIONARY数据库中。 

设计数据库的更新 

1. 设计数据库包括 DESIGN,DRAFT(PADD),ISODRAFT,CATALOGUE,PROPERTIES和
DICTIONARY。 



  项目管理 
 

VANTAGE PDMS培训手册  11-35 
 

2. 当 PDMS用户添加，改变或删除一个元素，这种变化并不马上写到数据库中，首先保
存在内存中，如果内存不够，就在硬盘上生成一个临时文件。当 SAVEWORK，
FINISH或模块切换时，数据写到数据库的后面。如果 QUIT或者直接返回到
MONITOR，数据不会保存。 

3. 对数据库有只读权利的用户要想看到其他用户最新的保存的工作，要用到 GET 
WORK。 

数据库的设置 

1. 每一个数据库只属于一个组。所以，PDMS数据库的命名规则如下： 
TeamName/DatabaseName  

也就是说，生成数据库时首先要指定组。 
2. 一个组可以有多个数据库，像 CATS组，可以建管道元件库和钢结构元件数据库 
3. 数据库的控制级别有两种：UPDATE和MULTIWRITE。 
 
 
 

a) UPDATE允许一个用户写，多个用户读。这个项目中的数据库控制级别都是
UPDATE。加上CONTROLLED 选项有内部警告信息。 

b) MULTIWRITE允许多个用户写，多个用户读。后面项目中要用到。  

练习三：生成设计数据库 CREATE DATABASE 

数据库描述 工作组/数据库名称 数据库类型 
管道设计数据库(A区) PIPEA/DESIGN DESIGN 
管道设计数据库(B区) PIPEB/DESIGN DESIGN 
管道设计数据库(C区) PIPEC/DESIGN DESIGN 
管道设计数据库(D区) PIPED/DESIGN DESIGN 
钢结构设计数据库 STEEL/DESIGN DESIGN 
平面出图数据库(A区) PIPEA/DRAFT DRAFT 
平面出图数据库(B区) PIPEB/DRAFT DRAFT 
平面出图数据库(C区) PIPEC/DRAFT DRAFT 
平面出图数据库(D区) PIPED/DRAFT DRAFT 
提示：ISODRAFT不使用数据库，直接生成PLOT 文件。 
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练习四：生成元件数据库和出图定制库  

数据库描述 组/数据库名称 数据库类型 数据库号 
管道元件数据库 CATS/PIPE CATALOGUE 5050 
元件重量库 CATS/PROP PROPORTY 5051 
自定义属性库 ADMIN/UDA DICTIONARY 5052 
出图定制库 ADMIN/DRAFT DRAFT 5053 
像管道元件库这样可能被其他项目使用的数据库，需要特别指定数据库号 DB Number ，
在 PDMS项目中 DB Number 必须唯一。PDMS本身提供的 ANSI元件库的数据库号在
7000以上。用户生成的 Catalogue, Dictionary and Properties数据库号范围最好在 5050-6999
之间。如果数据库号有冲突，需要用 Reconfigure来解决。 

练习五：共享其他项目的元件数据库 INCLUDE FOREIGN DATABASE 

可以拷贝和共享其他项目的数据库，对于元件库通常采用共享的方法，可以节省硬盘空
间。当然，只能是只读方式。在这里，我们参考MAS项目中 ANSI标准的元件数据库。 

先选择组，
再命名 

选择数据
库类型 

选择 Update 
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生成共享数据库之前，必须做好两个准备： 
1. 共享数据库用到的 TEAM必须建好。 
2. 数据库号不能冲突。 

 
 
数据库内容 工作组/数据库名称 数据库类型 
PDMS 管道元件数据库 *MASTER/PIPECATA CATALOGUE 
PDMS 管嘴，UNITS，HVAC，CABLETRAY *MASTER/PIPEOLD CATALOGUE 
PDMS 钢结构节点数据库，自动出图设置，门
窗库，各国的型钢库，墙，地板 

*MASTER/STLCATA CATALOGUE 

PDMS HVAC 元件数据库 *MASTER/HVACCATA CATALOGUE 
PDMS 支吊架元件数据库 *MASTER/SUPPCATA CATALOGUE 
PDMS 参数化设备数据库，DIN 管嘴库 *MASTER/EQUICATA CATALOGUE 
PDMS 参数化设备模板库 *MASTER/EQUITMPL DESIGN 
PDMS 平台斜梯元件数据库 *MASTER/ASLCATA CATALOGUE 
PDMS 平台斜梯模板数据库 *MASTER/ASLTMPL DESIGN 
PDMS 支吊架及自动出图的 UDA 库 *MASTER/DICT DICTIONARY 
PDMS 元件特性数据库 *MASTER/PROP PROPERTIES 
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PDMS 模板数据库 *MASTER/TEMPLATE DESIGN 
PDMS 院级出图风格库 MASTER/PADD DRAFT 
PDMS 项目出图风格库 ADMIN/PADD DRAFT 
*星号表示参考数据库，在本项目中为只读。 

练习六：拷贝其他项目的数据库 COPY DATABASE 

拷贝 SAM项目中的 ADMIN/PADD项目出图风格库及MAS项目中的MASTER/PADD 通
用出图风格库。注意：用户不能改变拷贝数据库的数据库号。  

 
1. 选择外部项目 Foreign Projects 
2. 输入外部项目的用户名和密码。  
3. 选择外部数据库。 
4. 选择 Team用来放置拷贝的外部数据库。 
5. 可以修改数据库名。 
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显示数据库的完整信息 

Settings>Display Mode>Setup Admin Elements Form 

 
在 Database框中选取 Access和 Filename 



  项目管理 
 

VANTAGE PDMS培训手册  16-35 
 

 
调整 Admin elements对话框的大小 

Settings>Display Mode>Resize Admin Elements Form 

 
显示效果如下图 
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删除数据库  

为了避免错误发生，删除数据库的操作一定要在ADMIN模块中完成，而不应在操作系统
中完成。 

数据库组（Multiple Databases-MDBs）  

用户的操作不是针对项目中所有的数据库，将用户需要读或写的数据库放到一起，就是数
据库组 Multiple Databases-MDBs。一个项目至少要有一个MDB，而一个数据库可以是多
个MDB的成员。一个 MDB应该包括用户需要读写的所有数据库。例如，对于一个设计
人，MDB必须包括元件库和他本人的设计数据库。另外，这个MDB还要包括同一物理分
区中其他人的设计数据库，这样就可以看到整体的设计效果，方便模型的连接，避免碰撞
发生。 

WY
高亮
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练习七：生成数据库组MDBs 

在将项目数据库加到当前数据库时，应将设计数据库（有写权利的数据库）放在前面，参
考数据库放在后面,这个顺序很重要。见附图： 

 
生成下面的数据库组。 

PIPEA 
PIPEA/DESIGN 
PIPEB/DESIGN 
PIPEC/DESIGN 
PIPED/DESIGN 
STEEL/DESIGN 
PIPEA/DRAFT 
ADMIN/DRAFT 
ADMIN/PADD 
MASTER/PADD 
CATS/PIPE 
CATS/PROP 

PIPEA/DESIGN 必须
是 DESIGN数据库中
的第一个 

PIPEA/ DRAFT必
须是 DRAFT数据
库中的第一个 
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MASTER/UDA 
*MASTER/STLCATA 
*MASTER/PIPECATA 
*MASTER/PIPEOLD 
*MASTER/HVACCATA 
*MASTER/SUPPCATA 
*MASTER/EQUICATA 
*MASTER/EQUITEMP 
*MASTER/ASLCATA 
*MASTER/ASLTEMP 
*MASTER/DICT 
*MASTER/PROP 
*MASTER/TEMPLATE 

 
PIPEB 
包含的数据库与 MDB PIPEA 基本一样，但 PIPEB/DESIGN一定要是 DESIGN数据库中的第
一个， PIPEB/ DRAFT一定要是 DRAFT数据库中的第一个。 
 
PIPEC 
包含的数据库与 MDB PIPEA一样，但PIPEC/DESIGN一定要是DESIGN数据库中的第一
个， PIPEC/ DRAFT一定要是 DRAFT数据库中的第一个。 
 
STEEL 
应该加入管道设计库，因为在做楼板穿洞时，必须能看到管道模型。 
STEEL/DESIGN 
CATS/PIPE 
*MASTER/STLCATA 
PIPEA/DESIGN 
PIPEB/DESIGN 
PIPEC/DESIGN 
PIPED/DESIGN 
CATS/PROP 
MASTER/UDA 
*MASTER/PIPECATA 
*MASTER/PIPEOLD 
*MASTER/HVACCATA 
 
DRAFT 
用于 ADMIN用户设置出图风格库 
ADMIN/DRAFT 
ADMIN/PADD 
MASTER/PADD 
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CATAPIPE 
CATS/PIPE 
CATS/PROP 
*MASTER/PIPECATA 
*MASTER/PIPEOLD 
 
完成后如下图： 

 

用户 USER 

1. 定义用户的名字和密码。 
2. 确认从属关系，用户都要属于某一个组，用户只能对属于本组的数据库才有更改的权
利。组可以只有一个用户，也可以没有。在这个项目中DRAFTADMIN，ISOADMIN 
和 PARAGONADMIN组没有自己的用户，由专业负责人 ADMIN来管理。一个用户
也可以属于多个组，像 ADMIN和 SYSTEM。 

3. 指定用户的权限，用户的权限有两种：FREE和 GENERAL。FREE权限的用户可以进
入所有模块，可以更改所有的数据库。GENERAL权限的用户不能进入 ADMIN和
LEXICON模块，用户只能对属于本组的数据库才有更改的权利。 

4. 组，用户，数据库之间的关系：用户进入那个组，就可以做这个组的所有工作。 

练习八：生成用户 CREATE USER 

用户描述 用户名称/密码 用户权限 属于组 
管道设计人 A(A区) PIPEA/PIPEA General PIPEA 
管道设计人 B(B区) PIPEB/PIPEB General PIPEB 
管道设计人 C(C区) PIPEC/PIPEC General PIPEC 
管道设计人 D(D区) PIPED/PIPEC General PIPED 
钢结构设计人 STEEL/ STEEL General STEEL 
建元件库人 CATS/CATS General CATS 
专业负责人 ADMIN/ADMIN General DRAFTADMIN,ISOADMIN 
项目经理（已建立） SYSTEM/XXXXXX Free MASTER 
在这里要指定用户所在的组，在 USER MEMBERSHIP中左面是项目中的全部组，右面是
当前用户所在的组。 
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SAVE  WORK就完成了项目的规划和人员的安排。  

进入 PDMS时用户，模块及 MDB之间的关系 

User module MDB READ WRITE/UPDATA 
PIPEA DESIGN PIPEA 所有的设计数据库 PIPEA/ DESIGN 
PIPEB DESIGN PIPEB 所有的设计数据库 PIPEB/ DESIGN 
PIPEC DESIGN PIPEC 所有的设计数据库 PIPEC/ DESIGN 
PIPEA DRAFT PIPEA 所有的设计数据库，PIPEA 的 GA 图 PIPEA/ DRAFT 
PIPEB DRAFT PIPEB 所有的设计数据库，PIPEB 的 GA 图 PIPEB/ DRAFT 
PIPEC DRAFT PIPEC 所有的设计数据库，PIPEC 的 GA 图 PIPEC/ DRAFT 
STEEL DESIGN STEEL 所有的设计数据库 STEEL/DESIGN 
CATA Catalogue CATAPIPE 所有的管道元件数据库 CATA/PIPE 
CATA Catalogue CATASTL 所有的钢结构元件数据库 CATA/STEEL 
ADMIN DRAFT DRAFT 出图风格数据库 ADMIN/PADD 
ADMIN ISODRAFT PIPEA,B,C 所有的设计数据库 修改 ISO 选项 
ADMIN 全部 全部 所有的数据库 所有的数据库 
SYSTEM ADMIN   项目规划管理 

联机工作 

1. 项目目录共享，让其他联网计算机可以使用该项目。  
2. 在本地映射网络驱动器，指向项目的目录，如：H=\\Server\PROJECT。 
3. 修改和添加项目环境变量在 PDMS.bat文件中进行，在文件前面添加下面四行后存
盘。 
set ABC000=H:\ABC000 
set ABCISO= H:\ABCISO 
set ABCMAC= H:\ABCMAC 
set ABCPIC= H:\ABCPIC 
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4. 进入 PDMS，选择ABC项目。 

项目使用中的问题 1-每个分区要建立自己的 SITE。  

命名规则应由项目管理员制定。 

 

练习九：创建 SITE 

每个用户创建 SITE后，SAVE WORK。GET WORK可以看到其它用户的 SITE。 

 
项目使用中的问题 2-交叉数据库宏 Inter-DB Macro 
 

 

 框架区 塔区 

 炉区 

管带区 

P-101 

V-101 

CV-
101 

150-P-2003-2.5A1-HI 
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如果 PIPEN中的管道起点连在 PIPES中的设备管嘴时，PDMS要在设备管嘴中的 CREF属
性中写入管道信息，但 PIPEN对 PIPES的设计数据库没有写的权利，这时会自动生成交叉
数据库宏，把向 CREF赋值的过程写到宏文件中，让 PIPES自己执行宏程序，写入相关属
性。 

练习十：交叉数据库宏 

1. PIPEA用户生成设备 EQUIPA。 
2. PIPEB用户生成设备 EQUIPB，再生成管道从 EQUIPA到 EQUIPB，这时 PDMS会提
示“Attempt to connect to a read only database.Connection macro will be created”生成了交
叉数据库宏，保存在 ABCMAC 目录中 

3. 专业负责人（ADMIN）可以在 MONITOR模块中知道项目中那些数据库需要运行生
成的交叉数据库宏。一般在每天工作开始时，项目经理（SYSTEM）应当在
MONITOR 模块中检查交叉数据库宏，并提供给相关的组或用户。 

 
4. Data->Inter-DB Macro 

 
5. 专业负责人（ADMIN）提醒 PIPEB 的用户应在其 DESIGN模块中运行宏： 
6. $M /%ABCMAC%/ABC000.MAC 
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7. 运行过的宏可以删掉。 

规划项目二：多个用户使用一个数据库  

使用 Multiwrite Databases。  

因为同一个设备或管道不能被多个人同时编辑。所以，在Multiwrite Databases中，每个用
户必须声明要独占使用部分设备和管道。PDMS有两种声明方式：  
直接声明 Explicit claim：在使用前声明。  
隐含声明 Implicit claim：用到的实体自动加到声明列表中。 
如果要使用其他用户生成的设备或管道，必须提前声明，否则参考数据写不进去。一旦声
明成功，该用户就可以编辑其他用户生成的设备或管道。 
无论使用哪一种声明方式，用户之间都容易产生冲突。所以，PDMS不推荐使用多写数据
库。 

声明列表 

1. Utilities->Claimlists…将 EQUIPA加入到列表中。Claim->CE。 

 
在项目 ABC中使用 Multiwrite Databases 

1.在 ABC项目中增加一个组PIPE 
组描述 组名称 
管道设计组-负责 A,B,C区的管道，设备和平面图 PIPE 
2.将 ABC项目中的下列用户加入到PIPE 组中。 
用户描述 用户名称/密码 用户权限 属于组 
管道设计人 A(A区) PIPEA/PIPEA General PIPE 
管道设计人 B(B区) PIPEB/PIPEB General PIPE 
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管道设计人 C(C区) PIPEC/PIPEC General PIPE 
专业负责人 ADMIN/ADMIN General 除 MASTER外的所有组 
项目经理（已建立） SYSTEM/XXXXXX Free MASTER 
3．为 PIPE 组添加两个数据库，PIPE/DESIGN 和 PIPE/ DRAFT，存取权利均为
Multiwrite。使用直接声明Explicit claim。 
数据库描述 工作组/数据库名称 数据库类型 
管道设计数据库(A,B,C区) PIPE/DESIGN DESIGN 
平面出图数据库(A,B,C区) PIPE/ DRAFT DRAFT 
4．新建数据库组 PIPE 
注意：PIPE/DESIGN 一定要是 DESIGN 数据库中的第一个， PIPE/ DRAFT 一定要是 DRAFT
数据库中的第一个。 
PIPE/DESIGN 
STEEL/DESIGN 
PIPE/ DRAFT 
ADMIN/ DRAFT 
CATA/PIPE 
*MASTER/PIPECATA 
*MASTER/PIPEOLD 
*MASTER/HVACCATA 
*MASTER/SUPPCATA 
*MASTER/PADD 

项目管理工具 

数据库阶段性的保存  Database Sessions  

每次用户做了一次保存或者模块切换，PDMS将会把用户修改过的数据追加在原有数据库
的后面，原有数据库的内容并不改变。PDMS把新增的数据称为 SESSION，意思是阶段性
的保存。Session是顺序排列的。每一个数据库的 Session序列号是分开的，例如，数据库
TEAM1/DB1和 TEAM1/DB2保存后，生成的新的 SESSION序列号分别是 106和 289。如
果下一次 TEAM1/DB1又作了保存，它的 SESSION序列号累加至 107，而 TEAM1/DB2的
SESSION序列号保持不变。 
在 DESIGN，DRAFT，SPOOLER和 PARAGON模块中，用户都可以添加阶段性保存的注
释（Session Comment）,所以用户可以把当前的数据库与以前的数据作比较。 
注意：对以任何一个数据库，数据库生成时序列号为 1，当WORLD生成时序列号为 2，
所以用户的第一个序列号是 3。 

数据库回溯 Backtrack 

因为数据库有阶段性的保存，所以用户可以回到前面的任何一个阶段。步骤如下： 
1．选择菜单 DATA->Change Management->Backtrack Changes⋯ 
2．在弹出的对话框中，用户首先选择数据库，然后可以按时间或按照用户添加的注释查
看设计的各个阶段。MORE 按钮可以看到详细的信息。 
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3．假如如图所示，保存过 25 次 

 
４．回到 20 的效果如图。 
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数据库合并  

数据库可能保存了大量的阶段性的保存，这样会增加数据的存储空间，如果用户可以确保
以前的数据的正确性，用户可以合并这些阶段性的保存，以节省空间。 
1. 选择菜单 DATA->Change Management->Marge⋯ 
2. 在弹出的对话框中，用户首先选择数据库，点击Database Sessions按钮可以看到数
据库的详细情况。 

3. 压缩到 20 后的任务列表如下。 

 
4. 压缩全部选择All 

添加新
标记 26 
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显示菜单 Display 

 
锁定项目 LOCK 

系统管理员在使用 ADMIN模块时，锁定项目可以防止其他用户进入项目，直到
UNLOCK。 

 
改变密码 Change Password 

Settings->Change Password如果选择 Enabled，则允许用户修改个人密码，当用户进入
MONITOR 后，选择 Project->Change Password就可以改变密码，注意：需要输入两次确
认。否则，密码只能在 ADMIN中修改。 

 

模块定义Module Definition 

Project->Module Definitions。PDMS建议用户不要修改。 
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模块的使用权限（Security）现在只使用两种 

General:由 Free替代。 
Restricted:只有 Free的用户可以进入。 
Free:普通用户可以进入。 

 

数据完整性检查 PDMS Data Integrity Checker (DICE) 

Utilities->Integrity Checking 
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The main checks are: 

• Is the complete data hierarchy intact? For example, do all lists contain 
all of the members that they should contain? 

• Are all element names correctly stored and accessible? 

• Are references to other databases valid? If not, a warning will be output. 
The most likely cause is a deleted database. 

The most probable causes of database corruption are: 

• An error in the network, resulting in loss or non–arrival of data. 
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• An error on copying databases. In particular, this can lead to truncated 
databases. 

• Insufficient disk space or storage quota, so that the project area fills 
up while a database is being updated. 

• Deletion of a DB which is referenced from another DB.  

• Reconfiguration of a DB without a corresponding update of all DBs which 
have references pointing into it. 

• An undetected fault in the PDMS Database Management software 

It is recommended that DICE checks should be run frequently, for example, 
before a daily backup is taken. DICE should be run at least once a week. 

项目拷贝 Replicating a Project 

Porject>Replicate可以拷贝项目的所有数据到新的项目，也可以只拷贝项目的结构。注
意，项目的拷贝只能在 Admin模块中进行，不能在资源管理器中直接拷贝。 

 
练习：拷贝项目数据 

1. 按照前面建立项目的方法建立新项目的目录并且设置环境变量，假如新项目代码是
XYZ。 

2. 进入原项目 ,保证所有用户已经退出后 ,锁定项目。 
3. Porject>Replicate>Project data… ,键入新项目的代码，OK完成。 

 
练习：拷贝项目结构 

1． Porject>Replicate>Project  structure…自动生成Macro文件 
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2． 按照前面建立项目的方法建立新项目的目录并且设置环境变量，Make PDMS Project完
成项目基本设置。  

3． 以 SYSTEM／XXXXXX用户进入 Admin模块。打开命令行Display>Command Line。 
4． 运行前面生成的宏文件，自动生成用户，组，数据库和Mdb。 
 

重新配置 Reconfigure 

Reconfigure可以用于更新项目，在项目和数据库之间移动数据。 
Reconfigure的过程可以粗略地分为五个命令： 
FROM   数据来源 
TO   目标 
RCFCOPY    拷贝的数据 
RECON  Reconfigure命令 
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RCFUPDATE 当生成新的数据库时，PDMS是用的参考指针将会改变，该命令将更新所
有的数据库，将它们的指针指向新的数据库。  

Example of a Simple Reconfigurer 
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Example of Partial Reconfigurer 

 

在项目中有了两个同名设备 /32V01，但只有在 PIPEN/DESIGN 数据库中的是
正确的，PES/DESIGN中的同名设备应删掉。  

Example of a Reconfigure Sameref 

下面是 SAMREF选项使用的例子： 
FROM DB MASTER/DESIGN 
TO FILE /F1 /F2 
RCFCOPY ALL 
RECONFIGURE 
DELETE DB MASTER/DESING 
CREATE DB MASTER/DESIGN DESI DBNO nn 
FROM FILE /F1 /F2 
TO DB MASTER/DESIGN 
RECONFIG  SAMEREF 

字型设置 Font Families 

6 和 7 为等宽字符。 
Name Code 
Line 1 
Block 2 
Serif 3 
Italic  4 
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Script 5 
Typewriter 6 
UWLine 7         

(Uniform Width Line) 
AutoCAD字型文件*.shp可以转换成 PDMS的*.gfb字型格式文件，但需要CADCENTRE
提供的工具软件。 

直接进入设计模块 

跳过 LOGIN直接进入 PDMS的方法，在桌面创建批处理文件，文件中只有一行命令，分
别表示: pdms.bat的执行路径，项目名，用户名/用户密码，MDB，模块。如下所示： 
f:\cadcentre\pdms11.3\pdms.bat ABC PIPEA/PIPEA /PIPEA DESIGN  

数据备份 Daily Backups 

数据备份通常在每个晚上没有人使用系统的时候自动进行。一般备份项目目录
（ABC000）和 ISO选项目录（ABCISO）。 
下面是典型的备份表： 
Week No Monday Tuesday Wednesday Thursday Friday 
1 MON TUE WEEK 1 THU FRI 
2 MON TUE WEEK 2 THU FRI 
3 MON TUE WEEK 3 THU FRI 
4 MON  TUE MONTH 1 THU FRI 
5 MON  TUE WEEK 1 THU FRI 
6 MON  TUE WEEK 2 THU FRI 
7 MON  TUE WEEK 3 THU FRI 
8 MON  TUE MONTH 2 THU FRI 
9 MON  TUE WEEK 1 THU FRI 

项目备份 Project Backups 

当项目完成后，应当备份整个项目目录，图纸及报告。一式两份，存放在不同地点。 




